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Introduction to QGIS

Exploring the Map View

New Project Select feature by value
A . ?
Open Project Pan map

Identify feature

Save Project A Pan map to selection N

(@ nfitled|Project - QGIS
Prdjieq Edit View Layer Settinjs Plugins Vector Raster Database Web Processing |Help

BLEY B89 BPRA BENE 60 -H-oegEEsss-y D
BQV.AM L/ l = gl o

i

Deselect feature

Zoom In

Zoo tolselection

v
Zoom to layer Select feature by

Zoom out . .
Area or single click




Adding panels and toolbars

() *Untitled Project - QGIS

Project Edit View Layer Settings

BmE

[

BQV. 2% W

Manage Layers toolbar

5@@@aﬁ&yﬁaﬁl

Plugins Vector Raster Database Web Mesh MMQGIS SCP Processing Help

U pp P

&0 =0

<§) 12 pXx

Browse your folder and files to add any raster/vector layer

Browser

ORTHO

» [] 2 HydroSAR

» [ Agriculture_basic GIS
~ [9.REDD

] Plannings_activities
(] Random
1 Watershed Mana

4

Layer Order Browser

| ayers
o Bl % T & & AL

v M Nepal_population

& =

Y
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Displays the added raster /vector layer

Check/Uncheck to add
or remove the

Panel/Toolbar

%ZE'G \-ﬁ—lv
QR "R B ‘

Click on empty space

Panels
Advanced Digitizing Panel

Browser (2) Panel

V| Browser Panel

GPS Information Panel
V| Layer Order Panel
Layer Styling Panel

I
V| Layers Panel

Log Messages Panel
Overview Panel
V| Processing Toolbox Panel
Results Viewer Panel
SCP Dock Panel
Eia Search QMS Panel
Spatial Bookmark Manager Panel
Statistics Panel
Tile Scale Panel

Undo/Redo Panel

dvanced Digitizing Toolbar

ttributes Toolbar

ata Source Manager Toolbar

v

v

v

v WDatabase Toolbar
v Digitizing Toolbar
v | [Help Toolbar
v lLabel Toolbar
v

anage Layers Toolbar

Shape Digitizing Toolbar
Vv Snapping Toolbar
v Vector Toolbar
Vv Web Toolbar




Adding vector data - .

FY
[ Browser Source Type

‘¢ File ( Directory ' Database ' ' Protocol: HTTP(S), cloud, efc.
> LOUHCh QG'S +Ras_=t'er

lll Ao
=a Mesh

»Click on the Tab % | NI  Source

Encoding Automatic v

¥ Text Vector Dataset(s) kercises Day 1\Exercise 1'Bhutan Population.shp[ge ‘

“ﬁ GeoPackage

ot Add Vector data from the direcjory

Consult ESRI Shapefile driver help page for detailed explanations on optfons

»Click on Vector , PostareSQL

Ertan\E)(ercises Day 1\Exercise 1 ~ D Search Exercise 1 o
MSSQL
. f ¥ D == - TH @
»Navigate fo the folder Lorncle [
. . DE%'. DB2 A Ij Bhutan_Population.cpg T7/15/202171 2:41 PM CPG File
Where ‘I‘he exe rCISe d O'l‘(] I [1 Bhutan_Population.dbf 7/15/2021 2:41 PM DEF File
r
ﬂ Virtual A [ Bhutan_Population.prj 7/15/2021 2:41 PM PRI File
<% Layer I Bhutan_Population.shp 7/15/2021 2:41 PM__ SHP File  fi
I
ke p‘l‘ e TWMS/ D[] Bhutan_Population.shx 7/15/2021 2:41 PM  SHX File
+ “‘T\JITS ﬁ-' Population.csv 7/16/2021 8:27 PM Microsoft Exc
> Add vector file oee ‘ :
£ OGC API - |
hutan_Population.sh o All files (* ot
Features -oP P i

Bhutan_Population.shp 8 wos
. (Y. Close Add Help
from Day1\Exercisel




Adding vector data

(2 *Untitled Project — QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh MMQGIS Processing Help

DoERRY NLL,HAPPRP "R . B btNOR CEE#HI B -0 H-8--0 9 [z 2| px Y ® -

ROV L S - & e g e @ QQR n e
T ALl LLEY

| Browser
V;

O QESTHO . i )
¢ Favarites . Vectordata added in the display window
» " Spatial Bookmarks
9 » (4] Home
y [ CA

» [ DA
(YAl & GeoPackage
(] / SpatiaLite

@ PostGIS
@~ »MssQL
% @ Oracle
@~ DB2

» G WMS/WMTS

Vo~ HE Vector Tiles

v = XYZ Tiles

-

Layers

o @ % T &-RHEDL

ac

[ Bhutan Population

f

|ded layerin the layer panel




Exploring attribute table

| Q Bhutan_Population — Features T..  — O >
| / e v g ] 1) Y BE .5' 2 L
ADMI1 EN ADMI PCODE Pop 2005  *
> Right click on the added Layer i.e. | poowe pro ow =
e 2 Chhukha BT002 74,387
3 Dagana BTO003 18,222
[ ] |
Bhutan_Population.shp 4Gma B s
5 |Haa BTO005 11,648
|. k tt ° t I 6 Lhuentse BT006 15,395
» Click on Open Atiribute Table  r—
- & 2NOW IN UVErview —
8 Paro BT008 36.433
Show Feature Count —
9 Pemagatshel BTO009 13,864
Copy Layer —
10 Punakha BTO10 17,715
Rename Layer |
_ 11 Samdrupjon... BTO11 39,961
T B Duplicate Layer —
1aT 1 Samt: BT012 60.100
-ﬁ Spat1aL1te ﬂ Remove | aver E amise
@ PostGIS : 13 Sarpang BTO013 41,549
’ MSSOL EE Open Attribute Table -
Q 14 Thimphu BT014 98,676
@ Oracle oTogge tarng -
. 15 Trashigang BTO15 51,134
DB2 Filter... 7|
» B WMS/WMTS Change Data Source... ETrongsa BIOL7 13,419
i P Tsi BTO18 18.667
ﬁ Vector Tl'lles Set Layer Scale Visibility... E sirang '
v ::: XYZ Tiles ;
Layer CRS E‘hangdueph... BT019 31,135
ayers
b . Export EYangtse BTO16 17.740
« @ &7 &-F T Styles 20 Zhemgang  BT020 18.636 .
Bhutan Population _ 7 Show All Features _| El[=]
Properties...




Exploring attribute table

Invert selection

A
A ‘Organizecolumn
Selectall I peselectall : : Open field calculator
(2 Bhutan_Population — Features Total; E}.Eil‘nﬁed: 20, Selected: 0 E E T -
/)% 2 P eEdRTYESD BREE = 5@
abe District > =€ v || Update All | Upx
ADMI1 PCODE District Pop 2005
1 BT001 Bumthang 16,116
2 BT002 Chhukha 74,387
3 BTO003 Dagana 18,222
4 BTO004 Gasa 3.116
5 BTO005 Haa 11,648
6 BTO006 Lhuentse 15,395
7 BTO0O7 Monggar 37,069
8 BTO008 Paro 36,433
9 BTO009 Pemagatshel 13,864
10BT010 Punakha 17,715
11 BTO11 Samdrupjon... 39,961
12/ BT012 Samtse 60,100
13/BT013 Sarpang 41,549
14 BT014 Thimphu 98.676




Exploring attribute table

MMQGILIS Processmng Help

e opesco-Po-u K-e{egl ovlE  Ex  -re
g == . | Qe v

» Select a feature In 231 LELT

attribute table by clicking

Q Bhutan_Population — Features Total: 20, Filte... — Oa *

4 s & g AL TESP

on any row

ADMI1_PCODE District Pop 2005  *
BTO001 Bumthang 16,116
BT002 Chhukha 74,387

» Deselect by clicking on the

[ N|v—l

BT003

BT004 Gasa

BTO005 Haa 11,648

|

Deselect all icon

6 BTO006 Lhuentse 15,395
T_BTOO’,’ Monggar 37.069
8_ BT008 Paro 36,433
9_ BT009 Pemagatshel 13,864
EBTOIO Punakha 17,715
HBTOH Samdrupjon... 39,961

Al TTmaa [ R Fala Bt Wa¥al

'Y Show All Features




Changing colour of vector data

» Right click on the add

Layer

@ Information ~ M Fil
A8 Source M simple fill

& Symbology

Browser
ORETHO
7 Favorites
» " Spatial Bookmarks
» (4] Home
» [JCA
[ DA
& GeoPackage
/7 SpatiaLite
@} PostGIS
P MSSQL
@ Oracle
2 DB2
b 6B WMS/WMTS

HH Vector Tiles
4 4

Layers

Bhutan Population

(/O Zoom ta Layer

,Q Zoom to Selection
2 Show in Overview
Show Feature Count
Copy Layer
Rename Layer
Duplicate Layer
Remove Layer...

Open Attribute Table

= [ifi | §3 B

Togale Editing
Eilter...

Change Data Source...

Set Layer Scale Visibility...

Layer CRS
Export

Properties...

-> Properties-> Symbology

Labels
Diagrams
3D View

Source Fields itz

Attributes

Form Opacity
Joins

. Auxiliary
Storage

=

u@ Actions

(. Layer Properties - Nepal_population | Symbology >
E Single symbol v
Unit Millimeter hd
_1|100.0% |+
Color hd
< Favorites a - =§

L Display
4 Rendering
Variables

E Metadata

|

M Dependencies gradient
plasma

Legend
B8 QGIS Server

T Digitizing » Layer Rendering

Style =

gray 3 fill

hashed black /  hashed black \

-

Save Symbol | | Advanced ~

OK Cancel Apply Help

M




Changing colour of vector data

5 Single symbol v

> Click on the Symbology tab  EEl | ... |
» Select Simple fill under Fill

0 =h™

and click on the Fill Color

> Change the colors by e - e
choosing from the Palette of R g
the standard color -> click o p—
Apply S




Changing colour of vector data

Vector Raster Database Web Mesh MMQGIS Processing Help
IPR i R BeatlOR aEgkm-Jc -0y R-a-FK-5 9 vz [ Y ® -
- - g o : B Qe ©
cASEFNPED Z

— Q Layer Properties — Bhutan_Population — Symbology X

Q | = Single Symbol - |

-~ B Fi (& |
M Simple Fill -

& Symbology . |E| |E|

-

abe
abc
D Symbol layer type Simple Fill v
> [ il cotor |§| =l
E Fill style | ol1 - | €
= Stroke color (I | <.
Stroke width 10.260000 $ Millimeters  ~ | €,
Stroke style |—Solid Line v | €
%) Join style |. Bevel v | (ER
- x| 0.000000 B Pa——
Offset |M1111meters v | LER
. y 0.000000 I3
L
v| Enable symbol layer €L Draw effects
= » Layer Rendering
D

v| Style v| | OK || Cancel H Apply H Help




Changing colour of vector data

» Click on the Symbology Tab
» Dropdown from Single symbol

to Graduated

» Under Value select Popul_2005
» Change the colors by
f

the color ramp -> click Apply

choosing from the Palette o

No Symbols
= Single Symbo
= Categorized

= Graduated

=

(- Layer Properties — Bhutan_Population — Symbology

Select Graduated
123 Popul 2005

= Graduated

G’ Information Value

‘3\:\,‘_5_ Source

Symbol

Legend format %1 - %2 Precision (&

&Y Symbology
€™ Labels

&® Masks

-

Color ramp

Classes | Histogram

ﬁ 3D View

Symbol ~ Values Legend

¥ Diagrams vin 3116.00 - 22228.00 3116 - 22228
v 22228.00 - 41340.00 22228 - 41340
B Fields v I 41340.00 - 60452.00 41340 - 60452
: vl 60452.00 - 79564.00 60452 - 79564
RN 79564.00 - 98676.00 79564 - 986760452 - 79564

Joins

ﬁ Auxiliary Storage Select the column to be clas

Y

@ Actions
= Choose the color

® Display

Mode | . Equal Interval v Classes | 5 -
&  Rendering

> Symmetric Classification
& Temporal Classify | % =  Delete All Advanced ~

Variables v| Link class boundaries

a‘ Metadata

P Layer Rendering
— | Style ~

"™ Dependencies

oK Cancel

Apply

1

-I
-

sified




Changing colour of vector data

v = Bhutan Population
v/[ 3116 - 19043
v/[ 19043 - 34969
v/ [ ] 34969 - 50896
v/ ] 50896 - 66823
v/ [l 66823 - 82749

4 . 82749 - 98676 Coordinate 91.939,28.172 ¥ Scale 1:905957 ~ @ Magnifier 100%  Rotation 0.0° %+ v Render 4 EPSG:4326




Labelling vector data

> Right click on the added Layerau. s s o
-> Properties-> Labels lmsﬂ” A

s Choose the Label field

Labels
» Dropdown the No labels and Choose the Font
n 4
. | Lorem Ipsum 6| 1:2772891 ~ | By -
[ |
| _l_ so I I b I . : Source Fields ¢ Text Text
Se e C I n g e q e S - | B8l Attributes Form ' Formatting popt Times New Roman MKER
. : e Buffer
. Joins @ Backgrour Style Regular R =S
M 1 M I Auxiliar i
£ xiliary Storage ) Shadow
» Choose the Label fieid i.e. ® s Srbcren L ESE LT
- 5 tions _ . <
- ' / Rendering Size 6.0000 s a
. » Display a
| Points >
D iS.I.ri C.I. - & Rendering
- I -
. Variables Color =
. h Metadata Opacty o —100.0% |5 &
[ |
(2 Layer Properties - Nepal_Population | Labels ; X i DEraiaces Type case | No change v &
I No labels = I&‘ Legend Spacing letter |0.0000 SKES
b ™2 QGIS Server word |0.0000 K=t
B pigitzing Blend mode Normal MK ES

Apply label text substitutes

If the remove duplicate nodes
option is activated, duplicate

Diagrams

M

—

oK Cancel Apply Help |

3D View



Labelling vector data

= Bhutan Population
[ ]3116 - 19043
[ 119043 - 34969
[ 134969 - 50896
] 50896 - 66823
B 66823 - 82749
B 82749 - 98676




Why Project the layer?

» To represent the curved surface of earth on a flat surface
» Coordinates are recorded in a Linear Unit i.e. meter

» Easy to understand and for calculations

* Please note for any analysis (raster/vector) all the layers must have

similar CRS



Projection in QGIS

> Click ot the EPSG:4326 ©EPSG:4326

at the bottom right of QGIS

> In the Filter tab search UTM
zone 42 -> select WGS/UTM
zone 46N

¢ General

a‘ Metadata

f& Transformatio

Default
-/
¥ Styles

B Data Sources

= alatiane
& Relations

Variables
r® Macros
QGIS Server

o Temporal

Q Praject Properties — CRS

Project Coordinate Reference System (CRS)

No CRS (or unknown/non-Earth projection)

Filterl O utm 46 N
Recently Used Coordinate Reference Systems

Coordinate Reference System

1

Predefined Coordinate Reference Systems

Coordinate Reference System
Kalianpur 1975 / UTM zone 46N
MONREF 1997 UTM Zone 46N
WGS 72/ UTM zone 46N

WGS 72BE / UTM zone 46N
q

F

WGS 84 / UTM zone 46N
WKT
PROJCRS ["WGS B84 / UTM zone
46N",

BASEGEQOGCRS["WGS 24",
DATUM["World Geode -

P P S e W I | |

Authority ID

5
Hide deprecated CRSs

Authority ID -
EPSG:24346
ESRI:102224
EPSG:32246
EPSG:32446 -

Apply Help
————



Projection in QGIS

> You will observe the changed CRS below in the display window

Before After




X

o Save Vector Layer g5.. .
. €hoose the folder and name your file

Projection in QGIS e —

File nfme Lgs\WOGIT\Bhutan\rough Bhutan Population UTM.shp[g= ‘

. . Layer name Select the CRS as UT
R |g hT C | IC k on Th e |O yer B8 Vector Tiles [ayerCRS | CRS | Project CRS: EPSG:32646 - WGS 84 / UTM zone ;%q - || ®

4

Bhutan_Population.shp- =% ...... sy UTF-5 :

Prockrties. . Save only selected features

#* Bhutan Popul S
v [ 3116 - 19043

>Export-> Save Feature As «rios-sue

v [[] 34969 - 5

v Select fields to export and their export options

Name Type

. v District String
_— e e - - Save Selected Features

S e | e C-l- C RS G n d S p e C ify -l-h e Save as Layer Definitio v/ ADM1 PCODE String

Save as QGIS Layer Styl v Popul 2005 Integer64

A .

Save Features As...

parameters

Select All Deselect All

Give output file name as

v Geometry

Bhutan_Population_UTM.shp e Autoutic :

Force multi-type

Include z-dimension

v| Add saved file to ma Cancel




Projection in QGIS

> Right click on layer ->Properties-> Information and olbserve the

Difference

Before

(=) Layer Properties — Bhutan_Population — Information

Q

o Information

‘3\:‘\ Source

% Symbology

@7 Labels

(abc Y

ﬁ 3D View

'I Diagrams

E Fields

Attributes Form
Joing

ﬂ Auxiliary Storage

r@ Actions

@ Display

4" Rendering

a Temporal
Variables

a‘ Metadata

T Dependencies

Information from provider

Name
Path

Storage
Comment
Encoding
Geometry
CRS
Extent

Unit
Feature
count

Bhutan_Population
DAICIMODATO do\2021\CB

Trainings\WOGIT\Bhutan\Exercises\Day

1\Exercise 1\Bhutan_Population.shp

ESRI Shapefile

UTF-8
Polygon (MultiPolygon)
EPSG:4326 - WGS 84 - Geographic

88.7460414140000466,26.7006555370000456 :

92.1247543590000646,28.2476793010000620
degrees
20

|dentification

Identifier

Parent Identifier

Title

Style ~

OK Cancel = Apply Help

After

o |
-

o Information

‘:{:\\ Source

% Symbology

€ Labels

€EO Masks

\” 3D View

'I Diagrams

E Fields

Attributes Form
Joins

ﬂ Auxiliary Storage

r@ Actions
@ Display
& Rendering

” Temporal

Variables

a- Metadata
" Dependencies

-

() Layer Properties — Bhutan_Population_UTM — Information

Information from provider

Name
Path

Source

Storage
Comment
Encoding
Geometry
CRS

Extent

Unit
Feature count

Style ~

Bhutan_Population_UTM

DACIMOD\TO do\2021\CB
Trainings\WOGIT\Bhutan\rough\Bhutan_Popu
lation_UTM.shp

DAICIMODATO do\2021\CB
Trainings\WOGIT\Bhutan\rough\Bhutan_Pop
ulation_UTM.shp|
layername=Bhutan_Population_UTM

ESRI Shapefile

UTF-8

Polygon (MultiPalygon)

EPSG:32646 - WGS 84 / UTM zone 46N -
Projected
78255.0350313747767359,2957122.589928
6647327244 :
413378.3170038961106911,3128799.35730
49977421761

meters

20

OK Cancel || Apply Help




Calculating area

»Load Bhutan_Population_UTM.shp (you

created)

»Click on Vector->Geometry Tools ->ad

geomeiry atiributes

d
|
|
|

»>Select Input layer and CRS as Layer CRS:
»Dropdown Added geom info and selec’r:

Save to File

»>Select the output folder and n¢:

as Bhutan_Population_area.shp

15 Plugins Raster Database Web Pi
>RU|1 )| Ep &@ &(-: Geoprocessing Tools 4

Geometry Tools b

Analysis Tools

b
Data Management Tools ’
b

Research Tools

S¢ Collect Geometries...

7® Extract Vertices...
(o]

&~ Multipart to Singleparts...

X Simplify...
+/ Check Validity...
‘v Delaunay Triangulation...

4% Densify by Count...

P Lines to Polygons...
¢~ Polygons to Lines...
B8 Voronoi Polygons...

I
I
I
\

Q Add Geometry Attributes

Parameters | Log

iCﬂBhutan Population 1~ | 5) R

Selected features D&L n (L
oose the input Layer
Calculate using

Layer CRS

Choose the pr0|ec’r|on

Add geometry

attributes

This algorithm

CDlllp'I.lTE::- geometric

properties of the

features in a vector

il

Vi

[ERNUIN, [ Ty I
r.l

Create Temporary Layer

>

Fe

I_Addgd_ga\m info
an/rough/Bhutan Population area.

v Open output file after running algori

Choose the output foIcIer

| 0%

Run as Batch Process...

Run

I Save to File... |
Save to GeoPackage...

Save to Database Table...

c( Change File Encoding (Syste

measureIneiirs.

Depending on the

geometry type of the

1 ai

Close

Cancel

Help




Calculating area

Bhutan Puulatiun area

tutan_Population_U

(2 Bhutan Population

v [ ]3116 - 19043

v [ ] 19043 - 34969

v [ ] 34969 - 50896

v ] 50896 - 66823

v [ 66823 - 82749

v [l 82749 - 98676

File with added geometry

Added Area and Perimeter fields

Q Bhutan_Population_area — Features Total: 20, Filtered: 20, Selected:

u
P

District

1 |Yangtse
Zhemgang

Tsirang

Wangdueph. ..

Samtse

Pemagatshel

Punakha

Trashigang

10 Trongsa
11 Sarpang
12 Thimphu
13 Dagana
14 Gasa

15 Bumthang
16 Chhukha

v

2
3
4
5 Samdrupjon...
6
7
8
9

g a T
ADM1 PCODE Popul 200

BTO016 1774
BT020 1863
BTO18 1866
BT019 3113
BTO011 3996
BTO012 6010
BT009 1386
BTO010 1771
BTO15 5113
BTO017 1341
BTO13 4154
BT014 9867
BTO003 1822
BT004 311
BTO001 1611
BT002 7438

T Show All Features _

darca

1447892249.2241210...
2416914472.1926879...
638583262.48895263...
4040275931.5161132. ..
1874805195.2678833...
1308447242.6657257...
1021572033.5987548...
1111321481.5096435...
2201425461.4020385...
1814894287.1655273...
1656664102.0897216...
1799513737.1311645...
1725546886.6744079. ..
3139165218.6872253...
2718119249.7778930...
1883632872.9915466...

perimeter
230577.491...

290233.716...
150671.848...
419989.370...
233120.714...
251973.430...
196255.763...
166449.464...
282672.120...
250183.511...
286681.260...
321107.322...
238930.107...
354869.919...
281715.978...
264795.845. ..




Calculating area (Sq.Km) using field calculator

» Open Atftnibute Table -> Click
Toggle editingmode * >
Open Field Calculator [

» Give Output field name and type

»Select Geometry from the Row
groups -> Sarea

> Type the expression

Q Bhutan_Population_area — Field Calculator X

Only update 0 selected features

v Create a new field Update existing field
G asite i aleivadel
Output field name |Area (Sqkm ‘
Qutput field type | Decimal number (real) v
Output field length | 10 < | Precision |3 -
Expression = Function Editor
i 1 Q g e - =
B8 ats||nie A Sea... | |Show Help| | function $area

Sarea /1000000 Date and Time -

Fields and Values Returns the area of the

Files and Paths current feature. The area
Fuzzy Matching calculated by this
General

i v v v v «

e function respects both

penprlgmnimnps the current project's
ellipsoid setting and

ared area unit settings. For

’ L i t‘ll . . .
=+ =A=MY Mo Eiﬁﬁgaw example, if an ellipsoid
Feature |Bumthang ~ > bounds has been set for the

bounds height project then the

Preview: 2716.961389367008 bounds width ~

@ You are editing information on this layer but the layer is currently not in edit
mode. If you click OK, edit mode will automatically be turned on.

OK Cancel Help
—_— ———



Calculaﬁng aread

Bhutan_Population_area — Features Total: 20, Filtered: 20, Selected: 0 Added new field
AL A = B & L TESD EEEZER = 5 &
abe District v = & 'Jate All | L

District  ADMI1 PCODE Popul 2005 area perimeter Area (Sgkm

1 |Bumthang BTO001 16116 2718119249.7778930... 281715.978.|. 2716.961
2 Chhukha BT002 74387 1883632872.9915466... 264795.845.}. 1879.668
3 Dagana BTO003 18222 1725546886.6744079... 238930.107.. 1722.822
4 Gasa BTO004 3116 3139165218.6872253... 354869.919.|. 3134.402
5 Haa BTO005 11648 1909847354.1775817... 225456.752.|. 1904.537
6 Lhuentse BTO006 15395 2857938248.1088256... 304882.747.]. 2857.812
7 Monggar BTO007 37069 1943497121.9293823... 247600.411.}. 1943.556
8 Paro BTO008 36433 1290071403.5017395... 229941.715.}. 1287.000
9 Pemagatshel BT009 13864 1021572033.5987548... 196255.763.]. 1021.677
10 Punakha BTO010 17715 1111321481.5096435... 166449.464 .|. 1109.560
11 Samdrupjon... BT011 39961 1874805195.2678833... 233120.714.}. 1875.613
12 Samtse BT012 60100 1308447242.6657257... 251973.430.}. 1304.562
13 Sarpang BTO13 41549 1656664102.0897216... 286681.260.]. 1655.305




Joining Atfiributes

»Click @ and select Delimited Text

» Add Population.csv file from
Day1\Exercisel

> Select No geomelry under Geometry
Definition

»You will observe the data under
Sample Data

»Click ADD

Q Data Source Manager | Delimited Text

h B Browser

/- Vector
-8 Raster

Wl Ao

e Mesh

9 Delimited
Text

“?g GeoPackage

;‘; SpatiaLite
& PostgreSQL
, MSSQL
& Oracle

DE@'_ DB2

m Virtual Lay..
&2 WMs/WMTS

: WES / OGC
¢ API -
Features

L, wes

. XYZ

EEE‘_ Vector Tile

gy ArcGIS Map
&% Service

ArcGIS
i Featl.u'-e
Service

» GeoNode

"\WOG]T\Bhutan\Exercises

Layer name Population

v File Format

‘®) CSV (comma separated values)

) Regular expression delimiter

() Custom delimiters

v Record and Fields Options

Number of header lines to discard 0

v| First record has field names

v| Detect field types

Encoding UTF-8 v

-

Decimal separator is comma
Trim fields
Discard empty fields

v Geometry Definition

) Point coordinates

) Well known text (WKT)

‘®) No geometry (attribute only table)

» Layer Settings

Sample Data

s W R

District
Bumthang
Chhukha
Dagana
Gasa
Haa

Pop 2017
17,820
68.966
24,965
3,952
13.655

Close Add Help




Joining Atfiributes

»Right click on layer
Bhutan_Population_area.shp

-> properiies

» Click Joins

>Click on [# sign

»>Select the join layer

»Select the common join and
target field

»Click OK

(2 Layer Properties — Bhutan_Population_area — Joins

;  Information
‘1@ Source

%" Symbology
€3 Labels
€EB Masks
ﬁ 3D View

.
|

E Fields

Attributes Form

Diagrams

E" Auxiliary Storage

r@ Actions
@ Display

F 4 .
4 Rendering
e Temporal

Variables

| @ Add Vector Join

-h&t‘.ﬂ.ﬂ_‘ i!&lllﬂ

Select file to be joined™
Population * -

abe District -
abce District -

"Sélect the common join field

Create attribute index on join field

Join layer
Join field

Target field

v/ | Cache join layer in me

Dynamic form
b L Edigble join layer Select the common target
w v/ Ioined fields

District
V| Pop_2017

¥ /| Custom field name prefix

| oK Cancel

a\ Metadata I

g =71

"™ Dependencies

-

Style ~

@ Magnifier 100%

field

‘ OK ‘ Cancel Help

Coordinate 36186.2993664 ¥ Scale 1:1352974 ~ % Rotati




( ( o
OI n I n g rI U es Q Bhutan_Population_area — Features Total: 20, Filtered: 20, Selected: 0

. . - O
¢ B = B & A TESD ERBE S JQIned Fleldﬂ
abe District v |=&E v || Update All | Update S
District ~ ADMI1 PCODE Popul 2005 area perimeter Area (Sgkm Pop 2017 ~

1 |Chhukha BT002 74387 1883632872.9915466... 264795.845... 1879.66868,966

2 Samtse BTO012 60100 1308447242.6657257... 251973.430... 1304.562§62,590

3 |Paro BTO008 36433 1290071403.5017395... 229941.715... 1287.000§46,316

4 |Sarpang BTO013 41549 1656664102.0897216... 286681.260... 1655.305§46,004

5 |Trashigang BTO15 51134 2201425461.4020385... 282672.120... 2202.32845,518

6 |Wangdueph... BT019 31135 4040275931.5161132... 419989.370... 4035.593042.186

7 |Monggar BT007 37069 1943497121.9293823... 247600.411... 1943.556437,150

8 Samdrupjon... BTO011 39961 1874805195.2678833... 233120.714... 1875.613§35,079

9 |Gasa BT004 3116 3139165218.6872253... 354869.919... 3134.402)13,952

10 Punakha BTO010 17715 1111321481.5096435... 166449.464... 1109.560028.,740
11/Dagana BT003 18222 1725546886.6744079... 238930.107... 1722.822)424.965

12/ Pemagatshel BT009 13864 1021572033.5987548... 196255.763... 1021.677§23,632

13| Tsirang BTO018 18667 638583262.48895263... 150671.848... 637.830§22.376

14| Trongsa BTO017 13419 1814894287.1655273... 250183.511... 1813.597§19,960
15/Bumthang BT001 16116 2718119249.7778930... 281715.978... 2716.961417,820

16/ Zhemgang BT020 18636 2416914472.1926879... 290233.716... 2416.157Q17,763

17| Yangtse BTO016 17740 1447892249.2241210... 230577.491... 1448.266417,300

18 Lhuentse BT006 15395 2857938248.1088256... 304882.747... 2857.812Q14,437

19| Thimphu BT014 98676 1799513737.1311645... 321107.322... 1795.771§138,736

AAITTan nTons 11240 10NNATIEA 1778017 ANEASE 78R 1004 s27fl10 csx

T Show All Features

Export the data as Pop_Joined.shp
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